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Einfuhrung

Dieser Kurs wird einer Geschichte folgen, der Geschichte von Maya, der Imkerin. Alle Charaktere und
Ereignisse sind fiktiv, und um die Geschichte interessanter zu gestalten, sind wir vielleicht ein wenig
zu kreativ geworden. Wir hoffen, dass ihr uns Ungenauigkeiten und die Freiheit, die wir uns
genommen haben, verzeiht, besonders wenn jemand von euch selbst imkert.

Nach vielen Jahren als GIS-Spezialistin in Ziirich hatte sich Maya nach ihrer Pensionierung im Haus
ihrer Grosseltern niedergelassen und erinnerte sich an die vielen schénen Momente, als sie ihrer
Grossmutter beim Honigmachen half. Sie beschoss, in ihrer neu gewonnenen Freizeit zu Imkern.
Fir die Verwaltung ihrer Bienenstécke nutzt sie ihre Lieblingssoftware QGIS und die QField-App.
Und sie hat nicht nur ein Projekt fiir ihre Bienenstécke im Tessin erstellt, sondern hilft damit auch
ihrem Freund Flurin in Laax, Graubiinden. Dort werden wir unseren Kurs starten.

Vorbereitung

e QField auf einem Telefon oder Tablet installieren (Android, iOS, Windos) oder aktualisieren
e die folgenden Erweiterungen in QGIS installieren:

o QFieldSync

o Swiss Locator

o Swiss Geo Downloader
e ein Konto erstellen auf gfield.cloud

Die Anwendung QField dient Maya fir ihre Kontrollen. Mit der Erweiterung QFieldSync sendet sie
ihr QGIS-Projekt auf die Synchronisationsplattform QFieldCloud. Von dort Iadt sie es auf ihr Tablet
herunter. QField ermdglicht es ihr, genau die gleiche Symbolik und die gleichen Projekteinstellungen
zu verwenden, die sie in QGIS eingerichtet hat.

Flurin's Bienen in Graubiinden

Wir werden zunéchst Maya's und Flurin's Bienenprojekt im Dorf Laax in Graubiinden erkunden. Sie
sind stolz darauf und haben sich entschieden, es mit OPENGIS.ch zu teilen, damit andere von ihrer
Arbeit profitieren kénnen.

(Lokales Demo-Projekt)

e Benutzeroberflache
o QFC-Projekte und lokale Projekte
e Hauptmeni
= Einstellungen
= Drucklayouts
=  Projektordner
= Messwerkzeug
= Rickgangig machen
= Nachrichtenprotokoll
e Lokalisierung
e Suche
o Digitalisierungsmodus und Navigationsmodus
= ein Objekt abfragen
= ein Attribut &ndern
= eine Geometrie bearbeiten
= ein Objekt hinzufiigen
e Legende
o Kartenthemen und -stile
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Tracking
Objektliste (Attributtabellen)
Auswahl eines oder mehrerer Objekte
=  Aktionen auf ausgewahlten Objekten
=  Geoverarbeitung
Ein Foto aufnehmen
= oder Video und Audio
= eine Skizze machen
= auf ein Foto zeichnen

QField-Projekt fuir die Bewertung von Restaurants

Maya liebt es, im Restaurant zu essen, und méchte auf einer Karte die Restaurants erfassen, die sie
an verschiedenen Orten testet. Wir richten zusammen mit Maya das QField-Projekt ein.

Da sie eines Tages das Projekt mit ihren Freunden teilen méchte, um untereinander Restaurant-
Empfehlungen auszutauschen, entscheidet sie sich fiir eine Synchronisation liber QFieldCloud. Dies
wird die Zusammenarbeit und den Datenaustausch erleichtern.

Um Fehler oder Probleme im Projekt zu vermeiden, mussen einige Bedingungen beachtet werden:

¢ Alle notwendigen Dateien (QGIS-Projektdatei, Daten, Bilder, Symbole) missen sich im selben
Ordner befinden.

e Indiesem Ordner darf nur eine QGIS-Projektdatei vorhanden sein.

o Alle Layer wurden fir QFieldCloud oder den Export/Import per Kabel Uber die
Projekteinstellungen konfiguriert.

e Die Daten befinden sich im gleichen Koordinatensystem (KBS).

Hinzufuigen von Hintergrundkarten fiir die Online-Nutzung

Fiir die ersten Tests ist Maya zuversichtlich, dass sie in der Stadt Netzabdeckung hat. Sie entscheidet
sich fiir eine direkte Verbindung zu ihren Hintergrundkarten.

Wenn sichergestellt ist, dass wahrend der Feldarbeit eine Verbindung zu mobilen Daten gewahrleistet
ist, kdnnen die Hintergrundkarten als WMS oder WMTS verwendet werden.

Im leeren QGIS-Projekt figt Maya mit Hilfe der Swiss Locator Erweiterung SWISSIMAGE
Hintergrund und Karte swissTLM (grau oder farbig) hinzu.

> in der QGIS-Suchleiste entsprechende Begriffe suchen und gewiinschtes Suchresultat anklicken,
um es ins Projekt zu integrieren.

Die Hintergrunddaten werden in einer neuen Gruppe ,Hintergrundkarten® (gegenseitig
ausschliessend) organisiert.

Daten fiirs Projekt erstellen

1. Erstelle ein Vektorlayer (Punkt) "restaurants"im LV95, EPGS:2056, fige Felder hinzu:
a. name betrieb (Text)

datum (Datum)

name person (Text)

bewertung (Ganzzahl)

Bonus: foto (Text)

© Q00T

(optional) Linien-Layer fur das Tracking des besten Wegs zum Restaurant
2. Erstelle eines Vektorlayers (Linie) "way" im LV95, EPGS: 2056, fuge Felder hinzu:
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a. bemerkung (Text)

Eingabeformular optimieren

3. Gehe =zu Layereigenschaften > Attributformular und wahle "Mit Drag & Drop
zusammenstellen”
4. Konfiguration:
a. Texteditor; setze ein Alias ,Name des Betriebs® und eine erzwungene NOT NULL-
Restriktion (harte Restriktion)
b. Datum/Uhrzeit; Vorgabewert now ()
c. Texteditor; Vorgabewert @cloud username
d. Wertabbildung
3 | Kdstlich
2 | OK
1 | Nicht empfohlen
setze eine nicht erzwungene NOT NULL-Restriktion (weiche Restriktion)
e. Anhang; Pfad speichern als relativ; Integrierte Dokumentenanzeige: Bild
docs.dfield.org/how-to/pictures/
f. Entferne das Feld fid aus dem Formular

docs.dfield.org/how-to/attributes-form/

Maya ist sich sicher, dass mit den eingebauten Qualitédtssicherungen auch ihre Freunde problemlos
und fehlerfrei Daten erfassen werden.

Symbolisierung und Beschriftung der Restaurants

5. Setze ein Punktsymbol fir die Restaurants
6. Setze eine Beschriftung, z.B. Name oder concat ("...")

Synchronisation aufs mobile Gerat vorbereiten

docs.dfield.org/get-started/tutorials/get-started-afs/
docs.qdfield.org/reference/qfieldcloud/system/

Maya hat die Erweiterung QFieldSync installiert, um das QGIS-Projekt mit QField zu synchronisieren.

> Erweiterungen > Erweiterung verwalten und installieren > nach QFieldSync suchen > Button
Erweiterung installieren, bzw. Erweiterung aktualisieren

Jeder Layer kann individuell konfiguriert werden.

(Diese Einstellungen findet man ebenfalls tiber Projekteigenschaften > QField)
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QFieldCloud Kabelexport

¢ Online-Layer bevorzugen Offline-Layer bevorzugen

w Einstellungen fiir einzelne Layer

. Filter Llayer... Nur sichtbare Layer anzeigen @

Layer - Aktion
1 " carte swisstim _co Directly access data source ~ Eigenschaften
2 restaurants Offline editing = Eigenschaften
3| ¥ SWISSIMAGE Fonc Directly access data source ~ Eigenschaften

Pushen Sie ausstehende Anderungen automatisch im folgenden Intervall

4

Generelle Einstellungen
Cloud-Layer Aktion | Offline editing -
Cable-Layer Aktion | Copy -

Geometrien sperren @ -

Einstellungen fiir Feature-Formular, Anhdnge und Beziehungen

Schwellenwert, bei dessen Unterschreitung die Widgets des Karten-Editors eine Schaltflache

zum Umschalten verwenden Deaktiviert
Feld Benennung des Ausdrucks
Anhang
Name 1| photo | 'DCIM/restaurants_' |f format_date(now(), 'vyyyMMddhhmmsszzz') || .{extension}' ~||E

Fir WMS- oder WMTS-Basiskarten ist zum Beispiel die Aktion ,Directly access data source” gesetzt,
die Daten werden online abgefragt und wiedergegeben.

In den Layereigenschaften jedes einzelnen Layers konnen ebenfalls individuelle Konfigurationen
gemacht werden. Maya lasst sie auf den Standardwerten.

Projekt in die QFieldCloud laden

Maya erstellt ein neues QFieldCloud-Projekt direkt aus QGIS und ladt ihr Projekt zur
Restaurantbewertung in ihr QFieldCloud Benutzerkonto.

Wihle aus, wie du ein neues Projekt erstellen willst

Aktuell gedffnetes Projekt in ein Cloud-Projekt umwandeln (empfohlen)

Ein neues QFieldCloud-kompatibles Projekt wird aus dem aktuell gedffneten QGIS-Projekt
erstellt. Dazu werden die Datensdatze in ein Export-Verzeichnis kopiert, das als lokaler Spiegel
fungiert. Vektordatensatze werden in das Geopaketformat konvertiert, um die
Datensynchronisation auf mehreren Geréten zu erleichtern, wihrend andere Datensatztypen
an den neuen Projekt-Standort kopiert werden.

o) Erstelle neues leeres QFieldCloud-Projekt

Es wird ein neues leeres QFieldCloud-Projekt erstellt. Sie sind dafiir verantwortlich, alle
projektbezogenen Dateien in das ausgewahlte lokale Verzeichnis zu verschieben, mit der
Projektdatei als Stammverzeichnis. Die Projektdateien werden erst hochgeladen, wenn Sie auf
die Schaltfliche "Synchronisieren" klicken. Stellen Sie sicher, dass das ausgewahlite
Verzeichnis nicht mehr als eine QGIS-Projektdatei enthélt.

Abbrechen Weiter

OPENGIS.ch Januar. 2026 7



QField Kurs OPENGIS.ch

OPEN-SOURCE GEONINJAS

Projekt-Details Wichtigste Informationen

Name maya_restaurants
s Name

Beschreibung

Besitzer isabel -||e Besitzer
Lokale Projekteinstellungen

Lokales Verzeichnis |l5er5;‘i5abe\kiefer;‘QFieId,'cIoud/HoneyHoneyInc_restaurants o) Pfad zum Projektverzeichnis

Zuriick Erstelle

@ Synchronisiere Projekt "linda/restaurants" *

QFieldCloud Projektname  linda/frestaurants

Lokales Projektverzeichnis |C:'Jzers\Lindz\QField\doud\restaurants

Some of the files on QFieldCloud differ from the files stored in the local project directory.

Mow you should choose what actions to perform on those files by dicking on the checkboxes in the file list below.

Checking the Tocal” action (under the computer icon) or "doud” action (under the doud icon) will mark that file as single
source of truth and will cause the file to be overwritten either in the doud or the local storage. All other files will not be

affected.
Dateiname o db Aktion
restaurants_cloud.ggs v n Hochladen (ersetzt die Datei in der Cloud)

restaurants_cloud_attachments.zip v ‘ Hochladen (ersetzt die Dateiin der Cloud)

Maya ist zufrieden, das Projekt steht nun in QField zur Verfligung.
E (2} QFieldCloud Projekte-Ubersicht
Hallo linda.
Name = Besitzer -

S

a5 E @ Rr{Cloud-Status: ok.
Lokaler Status: Projekt gespeichert unter "C:\UsersLinda\QField\doudrestaurants",
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My Projects Community

0

HoneyHoney_inc

G B2 &2

(T P

Sie hat sich ein leckeres Mittagessen verdient.

QField fur Navigation, Tracking und Restaurant-Bewertung

Navigation zum Ziel

https://docs.dfield.org/de/how-to/navigation/#navigation

Maya wéhlt als Ziel das Restaurant aus, wo sie essen mdchte, und setzt dies in QField als
Navigationsziel.

NS R Als Ziel auswahlen
i

Adresssuche

Maya weiss nicht genau, wo die gesuchte Strasse ist. Sie méchte die Adresssuche in QField selbst
machen. Sie hat herausgefunden, dass dies mit einem externen Plugin méglich ist.

— Nominatim-Plugin fiir die Suche nach Open Street Map

https://github.com/opengisch/gfield-nominatim-locator?tab=readme-ov-file

In QField im Menu Einstellungen > Plugins verwalten > 3 Punkte Menu > Reiter Verfiigbare Plugins >
OpenStreetMap Nominatim Search herunterladen und aktivieren.

Anpassen der Suchleiste

Plugins verwalten
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Maya gibt die Adresse in der QField Suchzeile ein und watrtet, bis sie die Adresse findet. Sie setzt es
mit Klick auf die violette Fahne direkt als ihr Navigationsziel.

! O aField = m| X
S — : w7y
b osm sumatrastrasse 11 zirich X j
N7 A et
) | place: house

e T T i iR T . T— 1 —— e ——— —

Anmerkung: Plugins, welche nicht direkt in der Liste "Available Plugins" erscheinen, kénnen Gber
"Plugin aus URL installieren" in QField installiert werden.

Weg aufzeichnen (Tracking)
https://docs.qafield.org/de/how-to/tracking/#tracking

Maya zeichnet sich ihren Weg auf, damit sie wieder gut zuriickfindet.

In QField lange auf den Layer dricken, in dem die Tracking-Daten landen sollen.
(Falls vorgangig im Restaurant-Projekt kein entsprechender Layer vorbereitet wurde, kann dies in
Flurin's Projekt bees (lokales Demo Projekt) am Layer Tracks ausprobiert werden.)

Lang-Klick auf Layer > Tracking einrichten > Einstellungen vornehmen > Tracking starten > Loslaufen
Um das Tracking zu stoppen, wieder lange auf den Layer driicken und Tracking stoppen.

Restaurant-Bewertung
Nach dem Essen und einem feinen Cappuccino macht Maya ihre erste Bewertung mit QField.
Draussen kénnen mehrere Funktionen getestet werden, z.B.:

¢ Digitalisieren mit der Lokalisierung

e Einstellungen der Lokalisierung (Genauigkeit, Informationen anzeigen, etc.)
e Foto aufnehmen

e Distanz messen

e PDF-Druck

Daten von QField auf den Computer synchronisieren
Maya mdéchte die erfassten Daten auf ihrem Computer (berpriifen.

1. Anderungen von QField in die QFieldCloud hochladen
2. Projekt in QGIS synchronisieren
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@ @ Synchronisiere Projekt "HoneyHoney_inc/maya_restaurants_demo"

QFieldCloud Projektname HoneyHoney_inc/maya_restaurants_demo

Lokales Projektverzeichnis |/Users/isabelkiefer/QField/cloud/HoneyHoneylnc__restaurants

Einige der Dateien in QFieldCloud unterscheiden sich von den Dateien, die im lokalen Projektverzeichnis gespeichert sind.

Wahlen Sie nun aus, welche Aktionen fiir diese Dateien durchgefiihrt werden sollen, indem Sie auf die Kontrollkdstchen in
der Dateiliste unten klicken.

Wenn Sie die Aktion "lokal" (unter dem Computersymbol) oder "Cloud" (unter dem Cloud-Symbol) ankreuzen, wird diese
Datei als einzige wahre Quelle markiert und entweder in der Cloud oder im lokalen Speicher Uberschrieben. Alle anderen
Dateien sind davon nicht betroffen.

Dateiname o & Aktion
~ DCIM
restaurants_20241115192713841.jpg B e ‘ v Datei aus der Cloud herunterladen
maya_restaurants.qgz v . Hochladen (ersetzt die Datei in der Cloud)
restaurants.gpkg n v Herunterladen (ersetzt die lokale Datei)

Achtung auf die Richtung der Aktionen, v.a. beim Geopackage!

Optimierung des Restaurant-Projekts in QGIS

Nach dieser ersten Erfahrung mit ihrem QField Projekt méchte Maya einige Punkte verbessern. Zum
Beispiel hat sie bemerkt, dass ihr Netzwerk doch manchmal ausféllt und ihre Hintergrundkarten dann
nicht sichtbar sind.

Hintergrunddaten fiir die Offline-Nutzung

https://docs.dfield.org/de/get-started/tutorials/get-started-afs/#hintergrundkartenkonfiguration

Oft stammt eine Hintergrundkarte von einem WMS- oder WMTS-Dienst, die nur online zur Verfligung
stehen. Im Feld ist jedoch nicht immer Netzabdeckung vorhanden. Es gibt verschiedene
Méglichkeiten, um Hintergrundkarten offline zu verwalten. Hier die zwei Hauptmaoglichkeiten:

R e (ber QfieldSync: (oder > Projekteigenschaften > QField)
&

QFieldSync kimmert sich darum, einen Ausschnitt der Hintergrundkarte im Format MBtiles zu
erstellen und ihn dem QField-Paket hinzuzufligen. Diese Option ist einfach, schnell
einzurichten und ermdglicht es, einen Hintergrund aus einer Kombination von Layern Uber ein
Kartenthema zu definieren.

~ (_]_@ Makros

. @ Einzellayer Kartenthema

3 T QGIS Server Layer M
~ @ Zeitiich Kachelgréfe | 1024 px =

Karteneinheiten pro Pixel | 10.00 mupp

1

7 l]:l Geldndehéhe

Tiles min zoom level | 14

i

¢ Sensoren

Tiles max zoom level | 14

E Qfield v Geofencing

o Die zweite Mdglichkeit besteht darin, selbst eine Hintergrundkarte in Form einer Datei zum
Projekt hinzuzufligen. Dazu muss zunachst der gewlinschte Kartenausschnitt als Rasterbild
heruntergeladen oder extrahiert werden. Im Folgenden wird das Vorgehen beschrieben.
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Maya méchte vermeiden, dass ihr Projekt zu viel Speicherplatz auf ihrem Telefon belegt. Dennoch
mdchte sie auch Zugriff auf Orthofotos haben, wenn sie in der Stadt unterwegs ist. Sie entscheidet
sich, die Kartenelemente im Vektorkachel-Format und ein Orthofoto im Geotiff-Format zu integrieren.

Beispiel Offline Orthofoto (Vorgehen flr Landeskarten analog):

1. Mit der Swiss Geo Downloader Erweiterung nach "SWISSIMAGE" suchen und installieren
2. Die Ausdehnung entsprechend der Ausdehnung des Karten-Ausschnitts festlegen (nur die
Innenstadt anzeigen)
Auf ,Liste der Dateien anfordern® klicken
Die gewlinschte Auflosung auswahlen (Achtung, 10 cm bendtigen viel Zeit)
5. Die zu herunterladenden Kacheln bestatigen > herunterladen
optional 6. und 7. (aus einzelnen Rastern eine Datei machen)
6. Die TIF-Dateien in einem einzigen virtuellen Raster zusammenfassen

o

Raster Datenbank Web Netz Verarbeitung Fenster Hilfe

{ ®= Rasterrechner... alo_de]
OpenTopography DEM > vig T 49 "~ /it‘x @ %:C:% 2
Analyse > r
Projektionen > B =l {:.:);‘
Sonstiges > 3‘ Virtuelles Raster gen
Extraktion > ¥ Rasterinformation...
Konvertierung > & Verschmelzen...

3¢ Raster anpassen... &, Ubersichten erzeugen (Pyramiden)...

< =

Kachelindex...

......

7. Als Geotiff exportieren und im Projektordner speichern.

Heruntergeladene Hintergrunddaten komprimieren

Fir grossere Ausschnitte lohnt es sich, das erstellte Orthophoto (oder die Karte) im GeoTiff-Format
zusatzlich in ein cloud-optimiertes Geotiff zu transformieren. Dies flhrt zu einer kleineren Datei und
einer besseren Ladeleistung der Karte.

Dies ist bisher nur beschrankt via QGIS-Oberfliche machbar, da die besten
Komprimierungsmethoden noch nicht eingebaut sind (beispielsweise wenn via Layer > Export ein
Raster erstellt wird).

Um ein Geotiff in ein Cloud-optimiertes Geotiff zu transformieren, die Python-Konsole 6ffnen und
zum Projektordner navigieren, der das Geotiff enthalt.

Falls nétig, os.getcwd () ausfilhren, um den aktuellen Ordner der Konsole zu ermitteln. Der Ordner
wird mit dem Befehl os.chdir (' [Pfad] ') geandert, wobei [Pfad] durch den Pfad zu eurem
Projektordner ersetzt wird.

!gdal translate raster.tif raster cog.tif -of COG -co  BLOCKSIZE=512 -co
COMPRESS=JPEG -co QUALITY=75 -co BIGTIFF=YES

Achtung: die Befehlszeile mit dem Dateinamen anpassen und.tif oder .tiff verwenden, je nach
Dateiformat.

Die Befehlszeile kann auch direkt in einer Konsole (z.B. osgeod4wshell) verwendet werden, in diesem
Fall das ,!“ am Anfang der Zeile entfernen. Dieses ist nur in der Python-Konsole innerhalb von QGIS
erforderlich.

https://docs.dfield.org/de/reference/data-format/#rasterdaten
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Relativ kleine und schnell ladende Hintergrunddaten im MBTiles-Format

MBTiles sind ebenfalls ein empfohlenes Datenformat fir QField. Es handelt sich um ein
Kachelkartenformat in einer einzigen Datei. Die gewilinschten Zoomstufen kdénnen ausgewahlt
werden. Es wird empfohlen, das JPG-Format zu verwenden, um eine angemessene Dateigrosse zu
gewabhrleisten.

Hintergrund als Vektoren dargestellt: Vektorkacheln

Swisstopo bietet ein Set von Vektorkacheln an. Eines der Vorteil von diesem Format ist, dass es viel
weniger Speicherplatz bendtigt als eine Datei mit Rasterdaten.

Die online-Version der Vektorkacheln lasst sich via Suchzeile laden, (Voraussetzung: SwisslLocator-
Erweiterung):

- _—

Swiss Geoportal Vector Tile Base Map Layers
, Base map
, Imagery base map
, Light base map
Swise Geoportal [ opendata.swiss Layers layers
Siiss Geoporis
0 division gok 200 raster
|, base map|

Der Download fir die Offline-Nutzung von Vektorkacheln erfolgt mit einem Algorithmus aus der
Verarbeitungswerkzeugkiste.

Verarbeitungswerkzeuge [S]E]
e 0ROy
. downl

~ () Dateiwerkzeuge

4¢ Datei herunterladen
v (2 GPS

5 GPS-Daten vom Gerat herunterladen
~ (2 Vektorkacheln

4f Vektorkacheln herunterladen

~ %% OpenTopography

Den Speicherort fiir die Ausgabedatei (derselbe wie Ihr QGIS-Projekt) und die Zoomstufen (z. B. max.
14) auswahlen. (Anmerkung: Felsschraffuren und ahnliches ist nicht darin abgebildet).

Maya (berpriift erneut die Einstellungen von QFieldSync und Iadt die neue Version ihres Projekts auf
QFieldCloud hoch.

Hintergrunddaten fiir mehrere QField-Projekte verwenden

https://docs.dfield.org/de/how-to/outside-layers/#geteilte-lokale-datensatze

Maya méchte die Mdéglichkeit haben, dieselben Hintergrundkarten in ihren anderen Projekten
wiederzuverwenden. Das spart ihr Speicherplatz auf ihrem Telefon sowie in QFieldCloud. Daher
testet sie die Methode der geteilten lokalen Datensétze.

Weitere mogliche Verbesserungen

o Einstellen der ,identifizierbaren® Layer
docs.qfield.org/how-to/map-styling/#read-only-non-identifiable-and-searchable-layers
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Beziehungen fir die Bewertungen
docs.qgfield.org/how-to/attributes-form/#configure-a-relation-widget
Kartenthemen

docs.dfield.org/how-to/map-themes/#map-themes

Formular mit Reitern, Behaltern

Sichtbarkeit eines Attributs im Formular steuern
docs.qgfield.org/how-to/attributes-form/#configure-conditional-visibility
Erweiterte Symbologie, Beschriftungen

Maximale Grosse der Fotos reduzieren
docs.dfield.org/how-to/pictures/#maximum-picture-size

Anhange konfigurieren
docs.qfield.org/how-to/attributes-form/#configurable-attachment-path

Verbindung zu Matteo's PostGIS-Datenbank

Hinzufiigen von Matteo's Daten

Matteo,

ein guter Freund von Maya aus Bellinzona, hat wéhrend seines Studiums an verschiedenen

Stéadten gelebt. Er hat ihr eine Liste von Sehenswiirdigkeiten und Restaurant zusammengestellt, die
sie besuchen sollte. Da Matteo auch sehr gut in GIS ist, hat er diese in einer PostGIS-Datenbank
gespeichert.

Im QGIS-Projekt zu Layer > Datenquellenverwaltung > PostgreSQL > Neu gehen

Name: (frei wahlbar, z.B.) demo db

Dienst:

Host: demopg.opengis.ch
Port: 21699

Datenbank: coursedemo

SSL-Modus: verlangen

> Verbindung testen

Authentifizierung, z.B. QFieldCourse
Benutzername: course participant
Passwort: ggis'!

Option Passwort in der Datei speichern:

Authentifizierung

Konfigurationen Basic

Benutzername |course_participant V| Speichern

Passwort (d) |eeees @ | |v| Speichern

Warnung: Zugangsdaten werden im Klartext in
* % Projektdatei gespeichert,

Konfiguration umwandeln

> Verbinden

Die Tabelle public.matteo poi wéahlen und zum Projekt hinzufligen
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Achtung: Wenn PostGIS-Daten in QField verwendbar sein sollen, ohne dass das Passwort in der
QGIS-Datei gespeichert ist, missen sie Uber einen pgservice-File verbunden werden.

Option (fir diejenigen, die bereits ein Servicefile auf ihrem Computer haben)
Hinzufligen

[pg afield course]
host=demopg.opengis.ch
port=21699
dbname=coursedemo
user=course participant
password=qgis!
sslmode=require

Mit der Datenquellenverwaltung eine neue PostgreSQL-Verbindung erstellen, die sich diesmal nur auf
den Namen des Dienstes stltzt. Die Verbindung kann z.B. demo db service genannt werden.

Auf dem Layer public.matteo poi Rechtsklick > Datenquelle &ndern > PostgreSQL > demo
db service.

Verbindungsdetails zur QFieldCloud hinzufugen

docs.dfield.org/reference/qgfieldcloud/secrets/

Damit QFieldCloud die Datenbankdaten verpacken und aktualisieren kann, muss im Projekt ein
neues "Secret" mit den Informationen aus dem pgservice-File hinzugefugt werden.

Flachengeometrien mit QField anpassen
Maya besucht Flurin in Laax. Sie freut sich, die Ruhe der Berge und die Bienen wiederzufinden.

Seit ihrem letzten Besuch wurden die Felder in der Umgebung geerntet. Die lokalen Landwirte haben
zwei Fldchen vergrdssert und einen neuen Weg in einem Lavendelfeld angelegt. Flurin schlidgt Maya
vor, eine Feldbesichtigung zu machen und seine Daten zu aktualisieren.

Sie laden weitere Freunde ein, die sie im QFieldCloud-Projekt hinzufiigen und ihnen die Rolle des
Editors zuweisen.

Das Projekt "bees" in QField 6ffnen und die verschiedenen Digitalisierungsfunktionen ausprobieren.

e Eine neue Ldéwenzahnfliche, die direkt an eine bestehende Flache anschliesst, wurde
vorbereitet.

e Das Grasfeld wurde in zwei Teile geteilt, auf einem Teil wurde Raps gesat.

e Ein neuer Weg trennt das Lavendelfeld.

e Zwei Felder am Rand von Laax wurden vergrdssert.

Alle laden ihre Anderungen in QFieldCloud hoch. Maya und Flurin sehen sich diese dann auf ihrem
Computer an. Wurde alles korrekt durchgefiihrt? Gab es Konflikte?

Bienenstocke mit externem GNSS-Gerat verbinden

docs.dfield.org/how-to/gnss/#using-an-external-gnss-receiver

Maya hat sich ein Happy MiniQ gekauft, ein GNSS-Gerét. Damit kann sie ihre Bienenstécke noch
préziser erfassen. Ausserdem wird sie die Unsicherheit der Positionsmessung kennen.
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Erkunden weiterer Moglichkeiten in QField

Profile zeichnen

docs.dfield.org/how-to/measuring-tool/#elevation-profiling

Eine Freundin von Maya, Roberta, schliesst sich ihr in Laax an. Zusammen mochten sie zu den
héchsten Bienenstécken wandern. Roberta ist nicht so sportlich wie Maya. Daher schauen sie sich
das Hdhenprofil an, um die Steigung und den Hbhenunterschied zu sehen. Falls es zu steil wird,
werden sie eine einfachere Wanderung machen.

i /4- - .‘- ‘ i
., |§§%.;'.‘,‘,€§3?-3«‘.{“ 4 6@

Length: 2.885 km
Lat: 46.81682
Lon: 9.26509

1,300

e SV

1,200

1,100

11

(R e T

0 500 1,000 1,500 2,000 2,50

AL B i WREATIR A T F o O e—— - o —— L eSS em R Er e —

Unerlaubte Zonen meiden (Geofencing)
opengis.ch/de/2024/10/08/gfield-3-4-ebo-geofencing-and-processing-out-of-the-box/

Maya und Flurin méchten vermeiden, versehentlich auf private Grundstiicke zu gelangen. Daher
zeichnen sie die Grenzen der privaten Grundstiicke und aktivieren das Geofencing flir diese.

Al sEE

O QField QField gibt dem Benutzer in Echtzeit Riickmeldung, wenn sich seine Geratepaosition innerhalb oder auBerhalb der von einem
- ausgewihlten Polygon-Layer definierten Bereiche befindet.

Geofencing-Bereiche Layer (9 Fields -
Geofencing-Verhalten Benutzer innerhalb eines Bereichs warnen -

Digitalisieren bei Alarmierung verhindern

Lesezeichen auf der Karte

docs.dfield.org/how-to/bookmarks/

Um schnell zwischen der Karte ihres Heimatdorfes Lavertezzo und Laax in Graubiinden zu wechseln,
fugt Maya fiir jeden Ort ein Lesezeichen in QField hinzu.

Weitere zu erkundende Funktionen

e Freihandzeichnen docs.dfield.org/how-to/digitize/#freehand-digitizing
e Externe Sensoren anbinden docs.qafield.org/how-to/sensors/
¢ Auf Fotos zeichnen oder Skizzenvorlagen verwenden
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docs.qgfield.org/how-to/pictures/#drawing-and-sketching
e QR-Codes oder NFC-Tags lesen docs.dfield.org/how-to/search/#search-with-code-
scanner und docs.gfield.org/how-to/search/#search-with-nfc
o Offnen von standalone Dateien docs.gfield.org/how-to/standalone-datasets/
e Ein Projekt als Kartenhintergrund festlegen
docs.qdfield.org/how-to/standalone-datasets/#using-a-project-as-base-map-for-
standalone-datasets
o Authentifizierung docs.dfield.org/how-to/authentication/
e Autovervollstandigungen eines Formulareintrags docs.(field.org/how-to/attributes-
form/#configure-auto-complete-value
e Geoverarbeitungswerkzeuge opengis.ch/de/2024/10/08/afield-3-4-ebo-geofencing-and-
processing-out-of-the-box/
e Fotos taggen
o Kartendekorationen (Titel, Copyright)

Tipps & Tricks

Verwendung auf dem Computer

QField kann auch auf einem Computer verwendet werden. Die Anwendung ist fur Windows, MacOS
und Linux verfigbar. Dies kann nutzlich sein, um QGIS-Projekte, die fur den Feldeinsatz vorbereitet
wurden, einfach zu testen oder um Personen, die QGIS nicht kennen, eine vereinfachte
Benutzeroberflache zu bieten,

Dokumentation und nutzliche Links

Dokumentation

Die Funktionsweise, Nutzung und Konfiguration von QField, QFieldSync und QFieldCloud ist hier
dokumentiert: docs.qafield.org.

Versionen

Informationen und Neuigkeiten zu den Versionen von QField kénnen hier eingesehen werden:
opengisch/dfield/releases.

Fur diejenigen, die die neueste Version haben mdéchten, ist es mdglich, die Beta-Version zu
installieren. Mit Feedback zu moglichen Bugs kénnt ihr uns helfen (opengisch/QField/issues).

Plugins in QField

Seit der Version 3.3 kommt QField mit einem Framework, das Erweiterungen (engl. Plugins)
unterstitzt. Dabei handelt es sich jedoch nicht um die gleichen Erweiterungen wie in QGIS. Die
QField-Erweiterungen werden in QML und JavaScript entwickelt.

Die Dokumentation flr die Entwicklung befindet sich hier: docs.afield.org/how-to/plugins/. Eine
Auswahl frei verfligbarer Erweiterungen kann hier gefunden werden: topics/gfield-plugin.

Mitmachen

e Feature-Anfragen auf der QField Ideas Platform (pour QField, QFieldSync et QFieldCloud):
ideas.qfield.org/app-feature-requests
e  Support: community.qgfield.org/; docs.dfield.org/get-started/support/
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Anhang |
QFieldCloud (app.gfield.cloud)

Die User, die Projekte, die Organisationen

https://docs.qfield.org/reference/qfieldcloud/concepts/
https://docs.dfield.org/reference/dfieldcloud/projects/
https://docs.qfield.org/reference/qfieldcloud/permissions/

Project Roles

|
j " Ackwin"
|
|
1
‘]-__ u “
‘ Morager
|
:}* "Editor"
Orsomisa\tion Roles :
————— "R erh"
| Teom ] eport
1 I
' _}"":“f-“_ 4 ‘
- S = "Reoder"
can - S, coan N - :
be / \‘ be I
A \ can be Project
" Adhwin” Meamb ‘ _______ Collaborator
WAL ember

has |

Ouwmer . Orgav\isa‘tion \,_ ~ - _con be hos
L owner =~ = - Project } 7‘ Owner
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can be
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Benutzeroberflache

& 4 < HoneyHoney_inc | bees &
i»

You are an admin of the owning organization .

Overvie
About

Files Created by HoneyHoney_inc 2 weeks, 1day ago. Last changed by HoneyHoney_inc 2 weeks,
1day ago.

Changes Demo project for QField courses Meant to be used and modified

Collaborators
Edit
Jobs

Secrets . . A
Settings -.- . k
4k 3

0 people involved 16 project files 0 changes
Add collaborators to Get access to your Your projectis a
involve more people in project on desktop and constantly evolving

your gecdata. mobile. miracle.

Synchronisation

Ein Cloud-Projekt existiert immer auch lokal. Es wird in QGIS konfiguriert und mit QFieldCloud
synchronisiert, um die Projektdatei (.qgs oder .qgz) und die Daten zu aktualisieren, die von den
Personen im Feld Gber QField an QFieldCloud gesendet wurden.

Wenn die Version einer Datei, die Teil eines Cloud-Projekts ist (.qgs- oder .qgz-Datei oder
Datendatei), neuer ist als ihr ,Spiegel” auf QFieldCloud, wird QFieldSync vorschlagen, die Dateien auf
QFieldCloud zu aktualisieren, also ein ,Upload®.

Wenn Daten von QField an QFieldCloud gesendet wurden (als ,Delta“), wird QFieldSync vorschlagen,
diese von QFieldCloud in das lokale QGIS-Projekt zu synchronisieren.

Von QGIS (up)
Anderungen im Projekt und in den Daten werden also nicht auf die gleiche Weise behandelt, je
nachdem, ob sie von QGIS oder QField stammen

QGIS: Die Dateiversion ist massgeblich, nicht die einzelnen Anderungen.

QField: Jede Anderung in den Daten wird individuell beriicksichtigt und als ,Delta“-Datei an
QFieldCloud gesendet.

Achtung: Das einfache Offnen einer GeoPackage-Datei in QGIS &andert deren ,Datum der letzten
Anderung“. Zum Zeitpunkt der Synchronisation wird daher immer vorgeschlagen, die Daten eines
Projekts mit einem GeoPackage in QFieldCloud hochzuladen, auch wenn sich diese tatsachlich nicht
geandert haben.

Deshalb wird empfohlen — nach der Erstellung des QFieldCloud-Projekts und der ersten
Synchronisation von QGIS aus — die Cloud-Version als die aktuelle Version der Daten zu betrachten.

Von QField (up and down)
Jede Anderung, die in QField vorgenommen wird, wird mit einer Nummer in einem blauen Punkt im
Cloud-Symbol sichtbar sein.

« m & @ G s
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Diese Anderung kann als ,Delta“ an QFieldCloud gesendet werden mit ,Anderungen pushen*.

Der ,Synchronisieren“-Button ladt zusatzlich ein neues ,Paket* des Projekis von QFieldCloud
herunter. Dieser Button ist daher nltzlich, um die neueste Version des Projekts zu erhalten oder sich
die Daten der andern Mitarbeiter:innen im Feld herunterzuladen.

: Der griine Punkt in der Wolke zeigt an, dass eine neue Version des Projekts auf QFieldCloud
verfugbar ist.

Nach QGIS (down)

Erneut Achtung: Das einfache Offnen einer GeoPackage-Datei in QGIS &ndert deren ,Datum der
letzten Anderung“. Zum Zeitpunkt der Synchronisation wird QFieldSync daher immer vorschlagen, die
Daten eines GeoPackage-basierenden Projekts nach QFieldCloud hochzuladen, auch wenn sich
diese tatsachlich nicht gedndert haben.

o @ Synchronisation du projet "HoneyHoney_inc/bees"

Nom de projet QFieldCloud HoneyHoney_inc/bees

Répertoire local du projet |/Usersfisabelkiefer/QField/cloud/HoneyHoneylnc__bees

| Certains fichiers sur QFieldCloud différent de ceux stockés dans le répertoire de projet local. |

Vous devez maintenant choisir quelle action doit &tre réalisée sur ces fichiers en sélectionnant
les cases & cocher dans la liste ci-dessous.

Sélectionner I'action "locale" (sous I'icone ordinateur) ou I'action "cloud" (sous |'icéne nuage)
marquera ce fichier comme point de référence unique et écrasera le fichier enregistré soit dans
le cloud, soit localement. Les autres fichiers ne sont pas impactés.

| Nom de fichier O & Action
~ datasets
bees.gpkg i v Télécharger (remplacera le fichier local)

Synchronisation (iber Kabel
QField-Ordner > import, QField-Ordner > export, Basisprojekt als Spiegel; Verpackung und
Synchronisation tber QFieldSync.

Verbindung zu einem Drittanbieter-Drive

Es gibt keine direkte Verbindungsmdglichkeit zwischen einem Drittanbieter-Drive (wie Google Drive
oder OneDrive) und QFieldCloud. Wenn das Projekt jedoch in einem Drive-Ordner gespeichert ist, der
mit dem Computer synchronisiert wird, ist es moglich, den Drive-Ordner (d.h. das QGIS-Projekt und
die Daten, Anhange) vom Computer mit QFieldCloud zu synchronisieren — und ihn somit als lokalen
~Spiegel” zu verwenden.
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